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Fogalmak, rövidítések  

Rövidítés, 
fogalom  

Magyarázat  

TIR Természetvédelmi Információs Rendszer 

TAR Természetvédelmi Alapobjektum-nyilvántartó Rendszer 

TAO Természetvédelmi Alap Objektum 

KöM Környezetvédelmi Minisztérium, a KvVM jogelődje 

KvVM Környezetvédelmi és Vízügyi Minisztérium 

TKSZ Természet- és Környezetmegőrzési Szakállamtitkárság 

NPI nemzetipark-igazgatóság 

ESZIR Erdészeti Szakmai Információs Rendszer 

OKIR Országos Környezetvédelmi Információs Rendszer 

KTJ Környezetvédelmi Terület Jel 

KÜJ Környezetvédelmi Ügyfél Jel 

Belső munkatárs Online csatlakozott munkatárs 

Külső munkatárs Terepen dolgozó, offline adatokkal dolgozó munkatárs 

Fömi Földmérési és Távérzékelési Intézet 

Küvet Külterületi Vektoros Térkép 

MSZ Magyar Szabvány 

TVH Természetvédelmi Hivatal 

Tvt. Természetvédelmi Törvény (1997. évi LIII. törvény) 

VPN Virtual Private Network (Virtuális Magánhálózat) 

EKG Egységes Kormányzati Gerincháló 
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1 Bevezetés 

1.1 ÁLTALÁNOS ISMERTETŐ 

A TIR rendszer 7 modulból áll. Ezen modulok a következők. 

 Biotika 

 Ingatlan-nyilvántartás 

 Védett értékek 

 Vagyongazdálkodás 

 Erdészeti nyilvántartás 

 Területhasználat eseménynapló (kezelés) 

 Vezetői döntés-előkészítés 
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1. ábra: A TIR rendszer egyes moduljai 

Az egyes modulok önállóan nem állják meg a helyüket.  A modulokról csak megjelenítési 

felület szinten beszélhetünk. Adatbázis tárolási szinten, az összes modul egy helyen, egy 

módon tárolódik.  

A jelen Felhasználói Kézikönyv által érintett DKEngine program a fenti modulok összes 

adatának megjelenítésére, valamint bizonyos adatainak adatmódosítására szolgál. 
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2 Telepítés 

A vastagkliens alkalmazások telepítése Windows telepítőkön keresztül történik. 

A következő telepítők érhetőek el: 

o DKENGINE 

o TIRextension  

o DKEngine_shared 

o CHECKINOUT 

Szükséges az ArcGIS Desktop 9.2 SP6 telepítése. 

A következőkben ismertetésre kerül, hogy melyik telepítő mire való. 

DKEngine. Az ArcEngine liszensszel is működő vastag kliens program. A 

DKEngine_shared és a TIRExtension funkcionalitását is tartalmazza, e mellett az ArcMap-

ben jellemzően használt funkciók lettek benne megvalósítva. 

CheckInOut. ArcMap-be épülő modul. E segítségével lehet adatokat a DKEngine-nek 

megfelelő struktúrában offline personal deoadatbázisba kivinni, visszahozni, illetve 

ArcPad-nek megfelelő formában kivinni. Personal deoadatbázisba kivitelnek két formája 

van: 

    altéma nélkül 

    altémával. 

Első esetben vissza csak szerződés tervezet, valamint területhasználati információ 

hozható a CheckInOut-tal. Második esetben az előzőeken felül a kivitt altémához rögzített 

adatok is visszahozhatók. 

DKEngine_shared. ArcMap-be épülő modul. Biztosítja mindazon szerkesztő funkciókat, 

amelyeket a projekt keretében a DK elkészített, ArcMap alá. Ezek: 

    BufferedLine 
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    BufferedPoint 

    CopyGeometry 

    CutPolygon 

    MergeFeatures 

    SplitPolygon 

TIRExtension. ArcMap-be épülő modul. Biztosít egy funkciót, egy info gombot, amivel a 

TIR szerinti alfanumerikus adallekérés valósítható meg ArcMap alatt. 

 

A telepítés javasolt menete a következő. 

1. DKENGINE. Telepítés végén ki kell választani a cél nemzeti parkot. A kiválasztás 

után a c:\TIR\config\desktop\Engine.cfg fájlban egyrészt javítani kell: 

<entry name="sde.user">sa</entry>, <entry 

name="sde.pwd">sa</entry> 

, másrészt pedig a <entry name="sde.source">172.31.36.11</entry>, 

valamint a <entry name="tir.url"> 

http://172.31.36.12:8080/tirWeb/tirInit.do </entry> 

bejegyzéseket ellenőrizni kell. Első az adatbázisszerver (lehet gépnév is), második 

az alkalmazásszerver. Ha valahol hiba van, azt javítani kell. 

2. TIRextension telepítő. Telepítés után az ArcMap-ben a Tools->Customize->Add 

from file...-nál ki kell választani a 

c:\tir\program\tirextension\TIRExtension.tlb-t. Majd Tools-

>Customize -ban a Toolbar fülön ki kell pipálni a TIR toolbar-t. Ezután mennie kell a 

zöld "i" gombnak. 

3. DKEngine_shared telepítő. Telepítés után az ArcMap-ben a Tools->Customize-

>Add from file...-nál ki kell választani a 

c:\tir\program\tirshared\DKEngineSharedCommands.tlb-t. Ok, ok, 

blocked::http://172.31.36.12:8080/tirWeb/tirInit.do
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majd a Commands fülről a TIRshared kategóriából a commandokat fel kell rakni a 

toolbar-ok egyikére. 

4. CHECKINOUT telepítő. Telepítés után az ArcMap-ben a Tools->Customize->Add 

from file...-nál ki kell választani a 

c:\tir\program\checkinout\CheckInOut.tlb-t. Ok, ok, majd a Commands 

fülről a TIR kategóriából a CheckInOut commandot fel kell rakni a toolbar-ok 

egyikére. 
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3 Konfiguráció 

3.1 KONFIGURÁCIÓS FÁJL 

3.1.1 DKEngine alkalmazás 

A c:\TIR\config\desktop\Engine.cfg fájl tartalmazza a konfigurációs beállításokat. A példa 

beállításban az egyes sorok után szerepel megjegyzésként, hogy az adott sor mit takar. 

<?xml version="1.0" encoding="utf-8"?> 

<profile> 

  <section name="Connections"> 

    <!-- MDB Connection --> 

    <entry name="mdb.provider">Microsoft.Jet.OLEDB.4.0</entry> 

    <entry name="mdb.source">..\Data\tir-local.mdb</entry> 

    <entry name="mdb.prefix">sde_dbo_</entry> 

    <!--entry name="mdb.mxd">..\Data\tir-local.mxd</entry--> 

    <!-- SDE Connection --> 

    <entry name="sde.provider">SQLOLEDB</entry> 

    <entry name="sde.source">dktir</entry> 

ArcSDE szerver neve 

    <entry name="sde.port">5151</entry> 

ArcSDE szerviz elérési portja 

    <entry name="sde.timeout">2000</entry> 

    <entry name="sde.catalog">sde</entry> 

ArcSDE adatbázis neve 

    <entry name="sde.user">sa</entry> 

ArcSDE-be belépő felhasználó neve 

    <entry name="sde.pwd">sa</entry> 

ArcSDE-be belépő felhasználó jelszava 

    <entry name="sde.prefix">sde.dbo.</entry> 

    <entry name="sde.mxd">..\Data\tir.mxd</entry>  

  </section> 

  <section name="TIR Desktop"> 

    <entry name="splash">hide</entry> 

    <entry name="startup.dialog">show</entry> 

    <entry name="hlp.path">DKEngine.hlp</entry> 

    <entry name="tir.url">http://dktir:8080/tirWeb/tirInit.do</entry> 

Alkalmazás nyitóoldala, ArcGIS Server nélkül 
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    <entry name="data.path">..\Data\</entry> 

    <entry name="snap.tolerance">10</entry>  

    <entry name="net.mode">offline</entry> 

  </section> 

</profile> 

3.1.2 CheckInOut 

A c:\TIR\config\arcpad\CheckInOut.cfg fájl tartalmazza a konfigurációs beállításokat. A 

példa beállításban az egyes sorok után szerepel megjegyzésként, hogy az adott sor mit 

takar. 

<?xml version="1.0" encoding="utf-8"?> 

<TIRProperties> 

  <SERVER>dktir</SERVER> 

ArcSDE szerver neve 

  <INSTANCE>5151</INSTANCE> 

ArcSDE szerviz elérési portja 

  <DATABASE>sde</DATABASE> 

ArcSDE adatbázis neve 

  <USER>sa</USER> 

ArcSDE-be belépő felhasználó neve 

  <PASSWORD>sa</PASSWORD> 

ArcSDE-be belépő felhasználó jelszava 

  <VERSION>SDE.DEFAULT</VERSION> 

ArcSDE-ben használt verzió neve 

  <MDBFILE>tir-local.mdb</MDBFILE> 

  <LOGPATH>c:\TIR\log\hiba.log</LOGPATH> 

  <MYTEST>c:\TIR\log\MyTest.txt</MYTEST> 

  <MESSAGEPATH>c:\TIR\log\uzenetek.log</MESSAGEPATH> 

  <ARCPADPATH>c:\TIR\data\arcpad\</ARCPADPATH> 

  <DBFPATH>c:\TIR\data\arcpad\</DBFPATH> 

  <EMPTYMDB>tir-empty.mdb</EMPTYMDB> 

  <ROOTPATH>c:\TIR\data\</ROOTPATH> 

  <MXDFILE>tir-local.mxd</MXDFILE> 

  <URESTABLAK>c:\TIR\config\arcpad\</URESTABLAK> 

</TIRProperties> 
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3.2 MXD BEÁLLÍTÁSA 

Az ArcMap-be beépülő modulokkal, valamint a DKEngine alkalmazással is lehetőség van 

tetszőleges MXD használatára. Azonban ahhoz, hogy ezt a rendszerek TIR-nek megfelelő 

MXD-nek ismerjék fel, meg kell felelni  két követelménynek. Két tábla csatolt kell hogy 

legyen az MXD-ben. Ez a két tábla: 

o Altémák (BIO_ALTEMA) 

o Altémák (geometria) (BIO_ALTÉMA_GEOM) 

A BIO_ALTEMA táblának OLE adatbázis kapcsolaton keresztül kell csatoltnak lennie. Az 

OLE kapcsolat létrehozása ArcCatalog-ban történik. 

 

Itt az Add OLE DB Connection-re kell kattintani. 
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Ki kell választani a Microsoft OLE DB Provider for SQL Server-t, majd Tovább>. 
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Kiszolgálónév: (adatbázis gépnév),(port). Portot abban az esetben kell megadni, ha nem 

default instance-be lett telepítve az SQL Server. 

Felhasználónév: sa. 

Jelszó: sa. 

Jelszó mentésének engedélyezését ki kell pipálni. 

Kiszolgálón lévő adatbázis: sde. 

Ezután kapcsolat tesztelése. 
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Majd meg lehet nyomni az OK-ot. 

A BIO_ALTEMA_GEOM táblának Spatial Database kapcsolaton keresztül kell csatoltnak 

lennie. Az OLE kapcsolat létrehozása ArcCatalog-ban történik. 

 

Itt az Add Spatial Database Connection-re kell kattintani. 
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Server: (ArcSDE szerver neve). 

Serive: 5151. 

Database: sde. 

Username: sa. 

Password: sa. 

Transactional version: sde.DEFAULT. 

Ezután tesztelhető a kapcsolat. 
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Majd meg lehet nyomni az OK-ot. 
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4 DKEngine alkalmazás 

4.1 ÁLTALÁNOS BEVEZETÉS 

A DKEngine alkalmazás biztosítja az adatok elérését, szerkesztését a TIR-nek megfelelő 

formában. Az alkalmazás futtatásához elegendő egy ESRI-s Engine liszensz, vagy 

tesztőleges ArcMap liszensz. 

Az alkalmazás biztosítja a jellemző alap ArcMap funkcionalitást, kiegészítve mindazon 

funkciókkal, amelyeket a projekt keretében kifejlesztett a Vállalkozó. Ezek ismertetése 

következik a következő fejezetben. 

4.2 FUNKCIÓK 

4.2.1 Új térkép 

A funkció a Toolbar-on található  gombra kattintva érhető el. A funkció elérhető a File-

>Új menüpontból is. 

A funkció hatására egy üres térkép jelenik meg. 

4.2.2 MXD fájl megnyitás 

A funkció a Toolbar-on található  gombra kattintva érhető el. A funkció elérhető a File-

>Megnyitás menüpontból is, továbbá ezen funkcióval indul a DKEngine alkalmazás. 

A funkció hatására az MXD fájl kiválasztó ablak jelenik meg. 
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A kívánt MXD kiválasztása után a Megnyitás gombra kattintva nyílik meg a térkép. 

4.2.3 MXD fájl mentés 

A funkció a Toolbar-on található  gombra kattintva érhető el. A funkció elérhető a File-

>Mentés menüpontból is. 

A funkció hatására az MXD módosításai elmentésre kerülnek. 

4.2.4 Lapbeállítás 

A funkció a File->Lapbeállítás… menüpontból érhető el. 

A funkció hatására a lapbeállító képernyő jelenik meg. 
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Itt megadhatjuk a nyomtatandó lap 

 méretét 

 adagoló típusát 

 tájolását 

 margóit 

Az adatok módosítása után a OK-ra kattintva elmentésre kerülnek a módosítások, A 

Mégse… gombra kattintva pedig a program elveti azokat. A Nyomtató… gombra kattintva 

a nyomtató választó jelenik meg. 

 

Itt megint az OK gombot választva fogadjuk el a módosítást, Mégse pedig elveti azt. 
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4.2.5 Nyomtatási nézet 

A funkció a File->Nyomtatási nézet… menüpontból érhető el. 

A gombra kattintva az adott kivágat nyomtatási nézete jelenik meg. 

 

Itt a választható opciók sorban: 

 nyomtatás 

 nagyítás 

 egy lap 

 két lap 

 három lap 

 négy lap 

 hat lap 

 bezárás 



  

TIR – FHKK – Területhasználat 
nyilvántartás 

 

 

 

TIR_FHKK_DKEngine_v1.4 
Oldal: 24/63 

 

4.2.6 Nyomtatás 

A funkció a Toolbar-on található  gombra kattintva érhető el. A funkció elérhető a File-

>Nyomtatás menüpontból is. 

A gombra kattintva a nyomtató dialógusablak jelenik meg. 

 

4.2.7 Aktuális kép mentése 

A funkció a Toolbar-on található  gombra kattintva érhető el. A funkció elérhető a File-

>Exportálás… menüpontból is. 

A gombra kattintva az aktuális kivágat menthető el jpeg képformátumban. 
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Meg kell adni a kívánt fájl nevet, majd a Mentés-re kattintva azt elmenti, a Mégse gombra 

kattintva megszakítja a mentést. 

4.2.8 Nézet frissítése 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva az aktuális nézet újraolvasásra kerül. 

4.2.9 Teljes nézet 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a térkép teljes nézetére vált a program. 

4.2.10 Fix ráközelítés 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a közelít a térképen a program. 
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4.2.11 Fix távolítás 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a távolít a térképen a program. 

4.2.12 Ráközelítés 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a térképen téglalappal kijelölt  részre közelíthetünk rá. 

4.2.13 Távolítás 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a térképen téglalappal kijelölt  részen távoltthatunk. 

4.2.14 Mozgatás 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a térképen a bal gombot lenyomva és az egeret mozgatva 

mozgathatjuk a térképet. 

4.2.15 Előző nézet 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a térkép előző nézetére vált a program. 

4.2.16 Következő nézet 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a térkép következő nézetére vált a program. 
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4.2.17 Teljes képernyő 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva teljes képernyős nézetre vált a program. 

4.2.18 Koordinátára ugrás 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva koordinátát választhatunk. 

 

A menüsor funkciói: 

 rámozog 

 ráközelít 

 villogtat 

 pont hozzáadása 

 feliratozott pont hozzáadása 

 buborék hozzáadása 

 választott pontok listájának megtekintése 

 mértékegység választása 

4.2.19 ESRI Identify 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a sztenderd ESRI-s identify funkció jelenik meg. 
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4.2.20 Mérés 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva mérést lehet végezni a térképen. 

 

A menüsor funkciói: 

 vonal mérése 

 terület mérése 

 feature mérése 

 feature-höz snappelés be/kikapcsolása 

 összeg mutatása be/kikapcsolása 

 mértékegység választás 
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 adatok törlése 

4.2.21 Forgatás 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintás után a térképen a bal gombot lenyomva és mozgatva az egeret 

forgathatjuk a térképet. Az aktuális forgatási szöget kiírja a funkció. 

4.2.22 Forgatás törlése 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a forgatások törlésre kerülnek. 

4.2.23 Réteg  - kiválasztás megjelenítő 

A funkciócsoport a bal oldali panel fejlécében érhető el. 

 

Itt két opció található. 

 Fedvények. Megmutatja a rétegeket a térképen 

 Kiválasztás. A kiválasztható rétegek szerkeszthetők a segítségével. Egy rétegre 

kattintva a Fedvények fülön a, a kiválasztás is követi ezt, tehát az adott rétegről 
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lehet kiválasztani objekumokat, ezt nem kell ekkor külön bejelölni a Kiválasztás 

fülön. 

4.2.24 Réteg hozzáadása 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funciót kiválasztva réteget adhatunk a térképhez. 

 

4.2.25 Réteg törlése 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkcióra kattintva amennyiben van kijelölt réteg, az törlődik a térképből. 

4.2.26 Réteg tulajdonságok 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkcióra kattintva a kiválasztott réteg adatai jelennek meg. 
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4.2.26.1 ÁLTALÁNOS GOMBOK A DIALÓGUSABLAKON 

Rendben. A változtatásokat elmenti és bezárja a dialógusablakot. 

Mégsem. A változtatások menése nélkül bezárja a dialógusablakot. 

Alkalmzas. A változtatásokat elmenti. 

4.2.26.2 ÁLTALÁNOS ADATOK 

 

Rétegnév. A réteglistában megjelenő név. 

Leírás. Részletes leírása a rétegnek. 

Méretarány határok. Itt állítható be, hogy a réteg mikor jelenjen meg. Amennyiben nincs 

bepipálva a „Minden méretarányban mutatja”, akkor a minimum, maximum méretaránytól 

függően jelenik meg. A minimum méretarány alatt, illetve a maximum méretarány felett 

jelenik meg a réteg. 
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4.2.26.3 ADATFORRÁS 

 

4.2.26.4 FELIRAT 

 

Amennyiben a „Legyen feliratozva a réteg” be van pipálva, akkor beállítható a 

„Megjelenítendő mező”. Megadható a betűtípus, valamint a betűméret. Továbbá 

megadható a réteg megjelenéséhez hasonlóan, hogy milyen méretarányokon belül 

jelenjen meg a felirat. Amennyiben a „Minden méretarányban mutatja” be van pipálva, 

akkor a felirat mindig megjelenik, amikor a réteg megjelenik. 



  

TIR – FHKK – Területhasználat 
nyilvántartás 

 

 

 

TIR_FHKK_DKEngine_v1.4 
Oldal: 33/63 

 

4.2.26.5 MEGJELENÍTÉS 

Az oldalon levő gombra kattintva a réteg színe adható meg. 

 

Kitöltőszín. Itt adható meg, hogy milyen legyen a réteg háttérszíne. A legördülőben 

megtalálható az „Átlátszó” is, ekkor nem lesz kitöltve a réteg. 

Vonalszín. A réteg objektumait körbevevő vonal színe adható meg. 

Vastagság. A réteg objektumait körbevevő vonal vastagsága adható meg. 

4.2.27 Átlátszóság 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkcióra kattintva a kiválasztott réteg átlátszóságát adhatjuk meg 0-tól 100-ig. 

4.2.28 Réteg ideiglenes eltüntetése 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció mellet jobbra található a réteglista. 
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Amelyik réteg ebben kiválasztott azt a térképen a bal gombot lenyomva és az egeret 

húzva ideiglenesen eltüntethetjük. 

4.2.29 Térkép – nyomtatási oldal megjelenítő 

A funkciócsoport a jobb oldali panel fejlécében érhető el. 

 

Itt két opció található. 

 Térképi nézet. Megmutatja a térképet 

 Nyomtatási nézet. A térkép nyomtatási képét jeleníti meg. 

4.2.30 TIR identify 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

Offline esetben a program beépített identify funkciója indul el. 
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Itt a TIR adatszerkezetnek megfelelő adatkapcsolatok is elérhetők az egyes rétegekre. Az 

adatok szerkeszthetők. Természetesen a szerkesztésnek csak azon rétegeknél van 

értelme, ami a TIR SDE adatbázisába visszatölthető. 

4.2.31 Kiválasztás típusa 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a következő almenü jelenik meg. 

 

A -t kiválasztva sima kiválasztásként működik. 

A -t kiválasztva az összes objektum kiválasztásra kerül. 

A -t kiválasztva a képernyőn levő objektumokat választja ki. 

A -t kiválasztva a kiválasztások törlése történik meg. 
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4.3 SZERKESZTŐ FUNKCIÓK 

4.3.1 Szerkesztés 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A gombra kattintva a következő almenü jelenik meg. 

 

A egyes funkciók: 

 Start editing: szerkesztés megkezdése. 

 Stop editing: változások mentése és a szerkesztés abbahagyása. 

 Save edits: változások mentése. 

 Snapping…: snap beállítások. 

 

A fenti táblázatban beállíthatók az egyes használni kívánt snap típusok. 
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4.3.2 Visszavonás 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció az utolsó szerkesztési lépést vonja vissza. 

4.3.3 Újra végrehajtás 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció az utolsó visszavont szerkesztési lépést ismétli meg. 

4.3.4 Kivágás 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció a kiválasztott objektumokat vágólapra helyezi és törli. 

4.3.5 Másolás 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció a kiválasztott objektumokat vágólapra helyezi. 

4.3.6 Beillesztés 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció a vágólapon levő objektumokat beilleszti. 

4.3.7 Törlés 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció a kiválasztott objektumokat törli. 
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4.3.8 Attribútumok 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció a kiválasztott objektumokra jeleníti meg az ESRI-s identify adatait. 

 

4.3.9 Pont létrehozása pufferrel 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkcióra kattintva először a kívánt puffer értékét kell megadni. 

 

OK-ra kattintva elfogadásra kerül a puffer értéke, Cancel-re kattintva elvetésre. 

Ezután a képernyőn pontot lerakva a fenti pufferel növelt kör kerül lehelyezésre. 

4.3.10 Vonal létrehozása pufferrel 

A funkció a Toolbar-on található  gombra kattintva érhető el. 
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A funkcióra kattintva először a kívánt puffer értékét kell megadni. 

 

OK-ra kattintva elfogadásra kerül a puffer értéke, Cancel-re kattintva elvetésre. 

Ezután a képernyőn vonalat lerakva a fenti pufferel növelt vonal kerül lehelyezésre. 

4.3.11 Kiválasztott objektum másolása 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkcióra kattintva a kiválasztott objektum a jelenlegi rétegre másolódik. 

4.3.12 Automatikus kiegészítés 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkcióra kattintva a kiválasztott objektum a jelenlegi rétegre másolódik. 

A funkcióra kattintva rajzolást indítunk a kiválasztott rétegen. 

A réteg valamely objektumáról indulva kell pontokat lehelyezve megrajzolni a poligont 

határoló vonalat és a réteg egy objektumán befelyezni a rajzolást. Egy példa poligon: 
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4.3.13 Összevonás 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció a kiválasztott poligonokat vonja össze. 

4.3.14 Poligon vágása vonal mentén 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció a kiválasztott poligonokat vágja szét a térképre rajzolásra kerülő vonal mentén. 

4.3.15 Poligon vágása poligonnal 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkció a kiválasztott poligonokat vágja szét a térképre rajzolásra kerülő poligon mentén. 
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4.4 FÁJLMŰVELETEK 

4.4.1 Export 

4.4.1.1 TÉRKÉP KÉPKÉNT 

A funkció az File->Export->Térkép képként… menüpontból érhető el. 

 

A Fájlnév rovatban meg kell adni a menteni kívánt fájl nevét. A Mentés gombra kattintva a 

JPEG fájl létrejön. 

4.4.1.2 FAJOK CSV-BEN 

A funkció az File->Export->Fajok CSV-ben… menüpontból érhető el. 
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A Fájlnév rovatban meg kell adni a menteni kívánt fájl nevét .csv kiterjesztéssel. A 

rendszer ebbe a fájlba írja a fajokat csv formátumban a következő oszlopstruktúrával: 

 BID 

 X 

 Y 

 Faj 

 BORITAS_SZAZ 

 PONTOSSAG 

 EGYEDSZAM 

 EGYEDSZAM_HIM 

 EGYEDSZAM_NOSTENY 

 EGYEDSZAM_NEMMEGHAT 

 LELOHELY_KIT 

 MEGJ 

 NEM_PONTOS_FAJ_IN 

 NEM_PONTOS_ELOHELY_IN 

 NEM_PONTOS_LELOHELY_IN 

 NEM_PONTOS_DATUM_IN 

 NEM_PONTOS_GYUJTO_IN 

 MENNY_BECSLES 

 DT_FROM 

 DT_TO 

 AD_SKALA_ID 

 HATAROZO 

 SZAMOSSAG_ID 

 ELOHELY_ID 

 VESZELYEZTETETTSEG_ID 

 NOVENY_SZINT_ID 

 ELOFORD_ALL_ID 

 GYUJTO_3 

 GYUJTO_1 
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 ADATKOZLO 

 FAJ_ID 

 CON_ID 

 GYUJTO_2 

 MODSZER_ID 

 VNER_KOD_ID 

 EGYEB_KOD_ID 

4.4.1.3 FAJOK SHP-BEN 

A funkció az File->Export->Fajok SHP-ben… menüpontból érhető el. 

A menüpontra kattintva az export adatai módosíthatóak. 

 

Itt egy sql parancs jelenik meg. Ez módosítható, a „Mentés mint” gombra nyomva 

menthető vagy a „Megnyitás” gombra nyomva visszatölthető egy régebbi sql.  

Amennyiben nem kíván módosítani a felhasználó, akkor az „Exportálás” gombra kattintva 

futtatja az exportot. 

A fenti, alapértelmezett export formátumban a következő oszlopok kerülnek az shp-ba 

attribútumadatként. 

 fid 

 shape 

 faj 
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 számosság 

 egyedszám 

 egyedszám hím 

 egyedszám hőstény 

 egyedszám nem meghatározható 

 gyűjtő 1 

 gyűjtő 2 

 gyűjtő 3 

 határozó 

 adatközlő 

 módszer 

 hely_nev 

 hely_bid 

 geom_id 
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Itt kell megadni a menteni kívánt fájl nevét. A Mentés gombra kattintva a JPEG fájl 

létrejön. 

4.4.1.4 ÉLŐHELYTÉRKÉP 

A funkció az File->Export->Élőhelytérkép… menüpontból érhető el. 

 

Dátumtól, dátumig. Az élőhelytérképek készítésének a dátumára lehet szűrni. 

Filenév. Itt kell magadni a fájlszervízen azt a fájlt, ahova a rendszer elkészíti az élőhely 

exportot. Amennyiben a fájl neve xls kiterjesztésű, akkor XLS, amennyiben csv, akkor 

CSV fájlt hoz létre a rendszer. 

ADAT példa 

4.4.1.5 CÖNOLÓGIA 

A funkció az File->Export->Cönológia… menüpontból érhető el. 

 

Dátumtól, dátumig. Az cönológiai felvételek készítésének a dátumára lehet szűrni. 

Filenév. Itt kell magadni a fájlszervízen azt a fájlt, ahova a rendszer elkészíti a cönológia 

exportot. Amennyiben a fájl neve xls kiterjesztésű, akkor XLS, amennyiben csv, akkor 

CSV fájlt hoz létre a rendszer. 

Egy példa cönológia export adapadatok füle. 
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A fajadatok fül. 
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4.4.2 Import 

4.4.2.1 GPS 

A funkció az File->Import->GPS… menüpontból érhető el. 
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A megjelenő fájl kiválasztó ablakban ki kell választani az importálni tervezett fájlt. 

A fájl struktúrája a következő: 

 

Vagyis pontosvesszővel elválasztott oszlopokban a következő három adat van: 

 sorszám 

 EOV X koordináta 

 EOV X koordináta 

A fájl kiválasztása után a Megnyitás gombra kattintva olvassa be a rendszer a pontokat, 

100 méter sugarú körrel. 
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4.4.2.2 CÖNOLÓGIA 

A funkció az File->Import-> Cönológia… menüpontból érhető el. 

 

A megjelenő fájl kiválasztó ablakban ki kell választani az importálni tervezett cönológiai 

adatokat tartalmazó XLS fájlt. 

A fájl struktúrájának meg kell egyeznie a fentebb a cönológia export fejezetben ismertetett 

struktúrával. Két ellenőrzés fut le beolvasás közben, oszloponként. A HELY_BID sorban 

levő beszédes azonosítót megkeresi a rendszer a lelőhelyek között. Amennyiben nincs 

ilyen, akkor az oszlop hibás. Amennyiben van, akkor ehhez a lelőhelyhez kerül betöltésre 

a cönológiai felvétel. A másik ellenőrzés, hogy a cönológiai felvétel beszédes azonosítóját 

ellenőrzi. Amennyiben ilyen beszédes azonosító van már a cönológiai felvételek között, 

akkor az oszlop hibás. 

A fájl kiválasztása után a Megnyitás gombra kattintva olvassa be a rendszer az adatokat. 

A hibákat egy külön ablakban jelzi. 
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4.5 EGYÉB MENÜPONTOK 

4.5.1 Biotikai ellenőrzések 

A funkció az Eszközök->Biotikai ellenőrzések… menüpontból érhető el. 

A funkció megnyomására a funkció dialógusablaka jelenik meg. 

 

A funkció a következő geometriai ellenőrzéseket hajtja végre. 

 semmihez sem kapcsolódó rekord 

 nem cönológiai fajelőfordulás 

 növényszint nélküli fajelőfordulás 

 átfedő poligonok 
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 számosság nincs kitöltve 

 dátumig nincs kitöltve 

A funkció futtatásakor ellenőrzi a kiválasztott réteget és bejelöli rajta a fenti hibákat, illetve 

az alfanumerikus adatok a Megtekint gombra kattintva megtekinthetők, javíthatók. 

4.5.2 Geometriai ellenőrzések 

A funkció az Eszközök->Geometriai ellenőrzések… menüpontból érhető el. 

A funkció megnyomására a funkció dialógusablaka jelenik meg. 

 

A funkció a következő geometriai ellenőrzéseket hajtja végre. 

 létezik az entitáshoz geometria 

 leíróadatok kitöltöttsége 

 átfedő poligonvizsgálat 

 teljes kitöltöttség vizsgálat 

A funkció futtatásakor ellenőrzi a kiválasztott réteget és bejelöli rajta a fenti hibákat. 

4.5.3 Beállítások 

A funkció az Eszközök->Beállítások… menüpontból érhető el. 
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A funkcióra kattintva a beállítások dialógusablak jelenik meg. 

Könyvtárbeállítások. 

 

Ráhúzás. 

 

4.5.4 Súgó 

A funkció a Súgó-> Súgó … menüpontból érhető el. 

A funkcióra kattintva a súgó jelenik meg. 
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4.5.5 Névjegy 

A funkció a Súgó-> Névjegy … menüpontból érhető el. 

A funkcióra kattintva névjegy jelenik meg. 

 

4.5.6 Segítség 

A funkció a Toolbar-on található  gombra kattintva érhető el. 

A funkcióra kattintás után egy gombra kattintva jelenik meg a gomb részletes súgója.  

Egy példa súgó szöveg 
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5 CheckInOut 

5.1 ÁLTALÁNOS BEVEZETÉS 

A CheckInOut funkció biztosítja a fent használt offline adatok előállítását. E mellett ezen 

funkció állítja elő a PDA-n futó ArcPad alkalmazás számára a futtató fájlokat. 

Az adatok natív tárolási helye az ArcSDE adatbázisa. Ezen adatok itt minden esetben 

módosíthatók. Az adatok ArcSDE-ben történő módosítására a következő lehetőségek 

vannak: 

 tirWeb alkalmazáson keresztül. Az egyes modulok Felhasználói Kézikönyvei 

szólnak erről. 

 ArcMap alkalmazáson keresztül, natív ESRI eszközökkel. Az egyes grafikus térképi 

objektumok adatainak módosítására az ESRI biztosította eszközökkel is van 

lehetőség. Ezt az ArcSDE-n belül, valamint egy personal geodatabase-be való 

kicsekkelés, majd innen történő visszatöltés útján is van lehetőség. Ezen funkción 

keresztül csak a térképi objektum ESRI-s attribútumtáblájának, valamint a térképi 

foltoknak a módosítása lehetséges. 

 DKEngine alkalmazáson keresztül, personal geodatabase-ben. Ehhez kell az 

adatok TIR-nek megfelelő formájú exportját megtenni. A funkció használatát az 

SDE -> MDB fejezet ismerteti. Az ilyen módon kicsekkelt adatok egy része 

módosítható is. Ezek a következők. Minden esetben módosítható táblák. 

o Szerződés tervezet (VA_SZERZ_TERVEZET_GEOM) 

o Területhasználat eltérések (TH_ELTERES_GEOM) 

o Területhasználat események (TH_ESEMENY_GEOM) 

o Területhasználat kezelési célok (TH_KEZ_CEL_GEOM) 
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Ezen felül amennyiben biotikai adatokkal együtt történt a kicsekkelés, akkor 

rögzíthető 

o Lelőhely 

o Élőhely 

o Cönológiai adat 

o Fajelőfordulás 

 ArcPad alkalmazáson keresztül. Ehhez kell az adatok TIR-nek megfelelő formájú 

exportját megtenni. A funkció használatát az SDE -> DBF, MDB -> DBF fejezetek 

ismertetik. Ilyen módon csak biotikai adatrögzítésre van lehetőség. Az ArcPad 

alkalmazás leírása az ArcPad fejezetben történik meg. 

A funkció ArcMap beépülő command. A menüsorban a  ikonra kattintva érhető el. A 

kattintás után a következő ablak jelenik meg. 
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5.2 FUNKCIÓK 

5.2.1 SDE -> Access 

Az ablakból a funkcióhoz tartozó ablakrészlet a következő. 

 

A legördülő listában a TIR online rendszerében elérhető altémák jelennek meg, valamint 

egy Területhasznosítás (Altéma nélkül) sor. 

A legördülő listából ki kell választani a kicsekkelni kívánt altémát vagy a 

Területhasznosítás (Altéma nélkül) rovatot. Ez meghatározza, hogy a biotikai adatok közül 

melyek kerülnek ki a personal geodatabase-be.  

Az „Adatok MXD-ből” választógomb amennyiben be van kapcsolva, akkor az ArcMap-ben 

aktuálisan megnyitott mxd alapján készül el az export. 

A „Dátumszűrés” választógomb amennyiben be van kapcsolva, akkor exportba csak az 

export napján érvényes szótár elemek kerülnek be. 

Ez után a gombra kattintva amennyiben az „Adatok MXD-ből” választógomb be volt 

kapcsolva, akkor elindul az export, különben feljön az egyéb kicsekkelendő adatokat 

meghatározó ablak. 
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Itt modulonként elkülönítve találhatók az egyes adatok (táblák szintjén). Amit ki kíván vinni 

a felhasználó, ott a pipát be kell kapcsolni. Ezek után a Mehet gombra kattintva kezdődik 

meg az adatok kivitele. 

Mindkét esetben a kivitel során az aktuális folyamat a képernyőn követhető egy ablakban, 

majd a folyamat lezárultakor annak sikerességéről a felhasználó információt kap. 
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A personal geodatabase a c:\TIR\data\desktop\(altéma neve) könyvtárba kerül. 

A könyvtár az egyértelműség miatt (hogy kinek készült) átnevezhető. Ugyanezen 

könyvtárba kerül az alkalmazásban megnyitható MXD fájl is. Ezt egy minta MXD 

másolását jelenti. A minta a c:\TIR\config\desktop\tir-local.mxd. Ez azt is jelenti, hogy ez 

az MXD nem változik attól függően, hogy mely táblák kerülnek kicsekkolásra a personal 

geodatabase-ben. Vagyis az adatcsomag átadása előtt az MXD-t a kicsekkoló 

felhasználónak meg kell nyitnia és be javasolt állítani a kicsekkolt rétegeket, hogy eléhető 

legyen a rögzítőnek. 

5.2.2 SDE -> ArcPAD 

Az ablakból a funkcióhoz tartozó ablakrészlet a következő. 
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A legördülő listában a TIR online rendszerében elérhető altémák jelennek meg. 

A legördülő listából ki kell választani a kicsekkelni kívánt altémát. Az adatcsomag a 

c:\TIR\data\arcpad\(altéma neve) könyvtárba kerül. Ezt kell a PDA-ra másolni és 

megnyitásával rögzíthető a biotikai adat. 

5.2.3 Access -> ArcPAD 

Az ablakból a funkcióhoz tartozó ablakrészlet a következő. 

 

A legördülő listában c:\TIR\data\desktop\ könyvtár alatt elérhető könyvtárak nevei 

jelennek meg. 

A legördülő listából ki kell választani a kicsekkelni kívánt altémát. Az adatcsomag a 

c:\TIR\data\arcpad\(altéma neve) könyvtárba kerül. Ezt kell a PDA-ra másolni és 

megnyitásával rögzíthető a biotikai adat. 

5.2.4 ArcPAD -> Access 

Az ablakból a funkcióhoz tartozó ablakrészlet a következő. 
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A legördülő listában c:\TIR\data\arcpad\ könyvtár alatt elérhető könyvtárak nevei 

jelennek meg. 

A legördülő listából ki kell választani a becsekkelni kívánt altémát. Az ArcPad-ben rögzített 

adatok ekkor a c:\TIR\data\desktop\(altéma neve) könyvtár alatt elérhető 

personal geodatabase-be kerülnek betöltésre, amennyiben a két adatbázisban rögzített 

altéma azonosító megegyezik (vagyis történik egy ellenőrzés, hogy az altéma ugyanaz-e). 

A betöltés sikerességéről fentiekhez hasonlóan a felhasználó üzenetet kap. 

5.2.5 ArcPAD -> SDE 

Az ablakból a funkcióhoz tartozó ablakrészlet a következő. 

 

A legördülő listában c:\TIR\data\arcpad\ könyvtár alatt elérhető könyvtárak nevei 

jelennek meg. 

A legördülő listából ki kell választani a becsekkelni kívánt altémát. Az ArcPad-ben rögzített 

adatok ekkor az online adatbázisba kerülnek betöltésre, amennyiben az ArcPad 

adatbázisban rögzített altéma létezik az Sql Server-ben.  

A betöltés sikerességéről fentiekhez hasonlóan a felhasználó üzenetet kap. 
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5.2.6 Access -> SDE 

Az ablakból a funkcióhoz tartozó ablakrészlet a következő. 

 

A legördülő listában c:\TIR\data\dekstop\ könyvtár alatt elérhető könyvtárak nevei 

jelennek meg. 

A legördülő listából ki kell választani a becsekkelni kívánt altémát. A personal 

geodatabase-ben rögzített adatok ekkor az online adatbázisba kerülnek betöltésre, 

amennyiben a personal geodatabase-ben rögzített altéma létezik az Sql Server-ben.  

A betöltés sikerességéről fentiekhez hasonlóan a felhasználó üzenetet kap. 
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6 TIRExtension, DKEngine_shared 

Ezen két funkció biztosítja a prjojekt keretében kifejlesztett funkciók elérését ArcMap 

alkalmazáson belülről. 

A funkciók ennek megfelelően ArcMap beépülő commandok. 

A következő funkciók érhetők el a telepítés után. 

o TIR identify 

o Pont létrehozása pufferrel 

o Vonal létrehozása pufferrel 

o Kiválasztott objektum másolása 

o Automatikus kiegészítés 

o Összevonás 

o Poligon vágása vonal mentén 

o Poligon vágása poligonnal 

Az egyes funkciók részletes leírása a DKEngine alkalmazás fejezetben található meg. 
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7 ArcPad alkalmazás 

Az ArcPad alkalmazás használatos PDA-kon a fajelőfordulási adatok rögzítésére. 


